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Installing the MVI46-N2 module requires a reasonable working knowledge of the
Rockwell Automation hardware, the MVI46-N2 Module and the application in
which they will be used.

Caution: It is important that those responsible for implementation can complete the
application without exposing personnel, or equipment, to unsafe or inappropriate working
conditions. Safety, quality and experience are key factors in a successful installation.

1.1

System Requirements
The MVI46-N2 module requires the following minimum hardware and software
components:









Rockwell Automation SLC 5/02 M0/M1 capable processors (or newer), with
compatible power supply and one free slot in the rack, for the MVI46-N2
module. The module requires 800mA of available power.
Rockwell Automation RSLogix 500 programming software.
Rockwell Automation RSLinx communication software
Pentium® II 500 MHz minimum. Pentium III 733 MHz (or better)
recommended
Supported operating systems:
o Microsoft® Windows 98
o Windows NT® (version 4 with SP4 or higher)
o Windows 2000
o Windows XP
32 Mbytes of RAM minimum, 64 Mbytes of RAM recommended
50 Mbytes of free hard disk space (or more based on application
requirements)

ProSoft Technology, Inc.
October 27, 2008
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16-color VGA graphics adapter, 640 x 480 minimum resolution (256 Color
800 × 600 recommended)
CD-ROM drive
3.5 inch floppy disk drive
HyperTerminal or other terminal emulator program capable of file transfers
using Ymodem protocol.

Package Contents
The following components are included with your MVI46-N2 module, and are all
required for installation and configuration.
Important: Before beginning the installation, please verify that all of the following items are
present.
Qty.

Part Name

Part Number

Part Description

1

MVI46-N2
Module

MVI46-N2

Johnson Controls N2 Communication Module

1

Cable

Cable #15, RS232
Null Modem

For RS232 Connection to the CFG Port

3

Cable

Cable #14, RJ45 to
DB9 Male Adapter
cable

For DB9 Connection to Module's Port

2

Adapter

1454-9F

Two Adapters, DB9 Female to Screw Terminal. For
RS422 or RS485 Connections to Port 1 and 2 of the
Module

1

ProSoft
Solutions CD

Contains sample programs, utilities and
documentation for the MVI46-N2 module.

If any of these components are missing, please contact ProSoft Technology
Support for replacement parts.
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Install ProSoft Configuration Builder Software
You must install the ProSoft Configuration Builder (PCB) software in order to
configure the MVI46-N2 module. You can always get the newest version of
ProSoft Configuration Builder from the ProSoft Technology web site.
To install ProSoft Configuration Builder from the ProSoft Web Site
1
2
3

4
5

Open your web browser and navigate to http://www.prosofttechnology.com/pcb
Click the Download Here link to download the latest version of ProSoft
Configuration Builder.
Choose "Save" or "Save File" when prompted. The following illustrations
show the file download prompt for two of the most common web browsers.

Make a note of the location where you saved the file, for example "Desktop",
or "My Documents", so you can start the installation program.
When the download is complete, locate and open the file, and then follow the
instructions on your screen to install the program.

If you do not have access to the Internet, you can install ProSoft Configuration
Builder from the ProSoft Solutions CD-ROM, included in the package with your
MVI46-N2 module.
To install ProSoft Configuration Builder from the CD-ROM
1
2

Insert the ProSoft Solutions CD-ROM into the CD drive of your PC. Wait for
the startup screen to appear.
On the startup screen, click Product Documentation. This action opens an
explorer window.

ProSoft Technology, Inc.
October 27, 2008
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Click to open the Utilities folder. This folder contains all of the applications
and files you will need to set up and configure your module.
Double-click the ProSoft Configuration Builder Setup program and follow the
instructions on your screen to install the software on your PC.

Note: Many of the configuration and maintenance procedures use files and other utilities on the
CD-ROM. You may wish to copy the files from the Utilities folder on the CD-ROM to a convenient
location on your hard drive.

1.4

Setting Jumpers
If you use an interface other than RS-232 (default), you must change the jumper
configuration to match the interface. The following illustration shows the MVI46N2 jumper configuration:

The Setup Jumper acts as "write protection" for the module's flash memory. In
"write protected" mode, the Setup pins are not connected, and the module's
firmware cannot be overwritten. Do not jumper the Setup pins together unless
you are directed to do so by ProSoft Technical Support.
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Install the Module in the Rack
If you have not already installed and configured your SLC processor and power
supply, please do so before installing the MVI46-N2 module. Refer to your
Rockwell Automation product documentation for installation instructions.
Warning: You must follow all safety instructions when installing this or any other electronic
devices. Failure to follow safety procedures could result in damage to hardware or data, or even
serious injury or death to personnel. Refer to the documentation for each device you plan to
connect to verify that suitable safety procedures are in place before installing or servicing the
device.
After you have checked the placement of the jumpers, insert MVI46-N2 into the
SLC™ chassis. Use the same technique recommended by Rockwell Automation
to remove and install SLC™ modules.
Warning: This module is not hot-swappable! Always remove power from the rack before
inserting or removing this module, or damage may result to the module, the processor, or other
connected devices.
1
2

Turn power OFF.
Align the module with the top and bottom guides, and slide it into the rack
until the module is firmly against the backplane connector.

3
4

With a firm but steady push, snap the module into place.
Check that the holding clips on the top and bottom of the module are securely
in the locking holes of the rack.
Make a note of the slot location. You will need to identify the slot in which the
module is installed in order for the sample program to work correctly. Slot
numbers are identified on the green circuit board (backplane) of the SLC
rack.

5

ProSoft Technology, Inc.
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Turn power ON.

Note: If you insert the module improperly, the system may stop working, or may behave
unpredictably.

1.6

Connect your PC to the Processor
1

Connect the right-angle connector end of the cable to your controller at the
communications port.

2

Connect the straight connector end of the cable to the serial port on your
computer.
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Download the Sample Program to the Processor
To download the sample program from RSLogix 500 to the SLC processor:
Note: The key switch on the front of the SLC processor must be in the REM position.
1

If you are not already online to the processor, open the Communications
menu, and then choose Download. RSLogix will establish communication
with the processor.

2
3

Click the Download button to transfer the sample program to the processor.
RSLogix will compile the program and transfer it to the processor. This
process may take a few minutes.

4

When the download is complete, RSLogix will open another confirmation
dialog box. Click Yes to switch the processor from Program mode to Run
mode.

Note: If you receive an error message during these steps, refer to your RSLogix documentation to
interpret and correct the error.

ProSoft Technology, Inc.
October 27, 2008
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1.7.1 Configuring RSLinx
If RSLogix is unable to establish communication with the processor, follow these steps:
1
2

Open RSLinx.
Open the Communications menu, and choose Configure Drivers.

This action opens the Configure Drivers dialog box.

Note: If the list of configured drivers is blank, you must first choose and configure a driver from the
Available Driver Types list. The recommended driver type to choose for serial communication with
the processor is "RS-232 DF1 Devices".
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3

Click to select the driver, and then click Configure. This action opens the
Configure Allen-Bradley DF1 Communications Device dialog box.

4

Click the Auto-Configure button. RSLinx will attempt to configure your serial
port to work with the selected driver.
When you see the message "Auto Configuration Successful", click the OK
button to dismiss the dialog box.

5

Note: If the auto-configuration procedure fails, verify that the cables are connected correctly
between the processor and the serial port on your computer, and then try again. If you are still
unable to auto-configure the port, refer to your RSLinx documentation for further troubleshooting
steps.

ProSoft Technology, Inc.
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Connect your PC to the Module
With the module securely mounted, connect your PC to the Configuration/Debug
port using an RJ45-DB-9 Serial Adapter Cable and a Null Modem Cable.
1
2
3

Attach both cables as shown.
Insert the RJ45 cable connector into the Configuration/Debug port of the
module.
Attach the other end to the serial port on your PC or laptop.
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Module Configuration
In This Chapter


Installing and Configuring the Module ................................................... 19
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ProSoft Configuration Builder ................................................................ 21



Download the Project to the Module...................................................... 27

This section contains the setup procedure, data, and ladder logic requirements
for successful application of the MVI46-N2 module. Each step in the setup
procedure is defined in order to simplify the use of the module.
The section also contains a discussion of the data object defined for the module.
This single object completely encapsulates all the data required for module
operation. It is important to understand each element of the object for proper
application of the module.
The ladder logic requirement section defines the minimum ladder logic required
to apply the module in a user application. The logic is simple to understand and
implement.

2.1

Installing and Configuring the Module
This chapter describes how to install and configure the module to work with your
application. The configuration process consists of the following steps.
1

Use RSLogix to identify the module to the processor and add the module to a
project.

Note: The RSLogix software must be in "offline" mode to add the module to a project.
2

Modify the example ladder logic to meet the needs of your application, and
copy the ladder logic to the processor. Example ladder logic files are provided
on the CD-ROM.

Note: If you are installing this module in an existing application, you can copy the necessary
elements from the example ladder logic into your application.
The rest of this chapter describes these steps in more detail.

ProSoft Technology, Inc.
October 27, 2008

Page 19 of 68

MVI46-N2 ♦ SLC Platform
Johnson Controls N2 Communication Module

Module Configuration

First, define the module to the system. Select the I/O Configuration option from
the program screen. The system displays the following window:

Select the Other module from the list. This causes the system to display the
following dialog box:

Enter the module I/O card ID number as 12835, then click OK. Double-click the
mouse on the module just added to the rack. Fill in the dialog box as shown:

Click OK to apply the settings. Close this dialog box.
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The last step in the module setup is to add the ladder logic. If the example ladder
logic is used, adjust the ladder to fit the application. When the ladder example is
not used, copy the example ladder logic to your application and alter as
necessary.
The module is now ready to be used with your application. Insert the module in
the rack (with the power turned off) and attach the serial communication cables.
Download the new application to the controller and place the processor in run
mode. If all the configuration parameters are set correctly and the module is
attached to a network, the module's Application LED (APP LED) should remain
off and the backplane activity LED (BP ACT) should blink very rapidly. Refer to
the Troubleshooting section if you encounter errors. Attach a terminal to the
Debug/Configuration port on the module and look at the status of the module
using the Configuration/Debug Menu in the module.

2.2

Module Data
All data related to the MVI46-N2 module is stored in a user defined data file and
the module's M0 and M1 files. Additionally, a file should be defined to hold the
module status data. The status data should be copied from the M1 file and
placed in the assigned status file. The ladder logic is responsible for transferring
all received data from a module into the user data files and for transferring all
user data to the M1 file to be sent to the module.

2.2.1 MVI46-N2 Database Map
Start Address

End Address

Data

0

59

Binary Inputs

200

799

Analog Inputs

6000

6029

Error/Status Table

Data contained in this database is written through the M1 files by coordination of
the SLC logic and the MVI46-N2 module's program.

2.3

ProSoft Configuration Builder
ProSoft Configuration Builder is an application (computer program) that simplifies
the task of managing the configuration files that control how your ProSoft module
operates.
The following topics describe some of the features of ProSoft Configuration
Builder. For complete online documentation, please use the ProSoft
Configuration Builder online help.

ProSoft Technology, Inc.
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2.3.1 Configure the Module
Adding a Location
To add a location to an existing project file:
1

Right-click the Project icon and select Add Location. A new Location icon
appears.
or
Select the Project icon.

2

Choose Project from the Project menu, then choose Add Location. A new
Location icon appears.
or
If the Default Location has not been named (is not already an existing
project), right-click the folder and choose Rename.

3

Type in the Location name.

Adding a Project
To add a project to an existing project file:
1
2

Select the Default Project icon.
Choose Project from the Project menu, then choose Add Project. A new
project folder appears.

Adding a Module
To add a module to your project:
1
2

Double-click the Default Module icon to open the Choose Module Type dialog
box.
On the Choose Module Type dialog box, select the module type.

Or
1
2

Open the Project menu and choose Location.
On the Location menu, choose Add Module.

To add a module to a different location:
1

Right-click the Location folder and choose Add Module. A new module icon
appears.

Or
1
2

Select the Location icon.
From the Project menu, select Location, then select Add Module.
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Module Entries
To configure module parameters
1
2
3
4

to expand module
Click on the plus sign next to the icon
information.
Double-click the
icon to open the Edit dialog box.
To edit a parameter, select the parameter in the left pane and make your
changes in the right pane.
Click OK to save your changes.

Comment Entries
To add comments to your configuration file:
1
2

3

Click the plus sign to the left of the
icon to expand the Module
Comments.
Double-click the
icon. The Edit - Module Comment dialog
appears.

Enter your comment and click OK to save your changes.

Printing a Configuration File
To print a configuration file:
1
2
3
4

Select the Module icon, and then click the right mouse button to open a
shortcut menu.
On the shortcut menu, choose View Configuration. This action opens the
View Configuration window.
On the View Configuration window, open the File menu, and choose Print.
This action opens the Print dialog box.
On the Print dialog box, choose the printer to use from the dropdown list,
select printing options, and then click OK.

ProSoft Technology, Inc.
October 27, 2008
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2.3.2 [Backplane 46]
Read Register Start
Range 0 to 3999
This parameter specifies the starting register in the module where data will be
transferred from the module to the processor. Valid range for this parameter is 0
to 3999.
Read Register Count
0 to 4000
The Read Register Count parameter defines the size of the module's input
database, up to a maximum value of 4000 words.
Write Register Start
0 to 3999
This parameter specifies the starting register in the module where the data will be
transferred from the processor to the module.
Write Register Count
Range 0 to 4000
This parameter specifies the number of registers to be transferred from the
module to the processor. Valid entry for this parameter is 0 to 4000.
Error/Status Block Pointer
1 to 7000
The Error/Status Block Pointer parameter is used to specify the range of
database registers to use for error and status data. The value range should be no
lower than 700, to avoid overwriting data, and no higher than 6970, to allow
sufficient space for the error/status block.
Backplane Fail Count
0 to 65535
This parameter specifies the number of consecutive backplane transfer failures
that can occur before communications should be halted.
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2.3.3 [N2 Config]
This section is used to define the N2 configuration data.
Binary Input Object Count
0 to 960
Determines the number of Binary Input Objects available
Analog Input Object Count
0 to 300
Determines the number of Analog Input Objects available.
Binary Output Object Count
0 to 960
Determines the number of Binary Output Objects available.
Analog Output Object Count
0 to 300
Determines the number of Analog Output Objects available.

2.3.4 [N2 Port x]
This section is used to define the port configuration for the N2 device
Enable
Yes or No
This parameter specifies whether to enable or disable the port. No = Port
Disabled, Yes = Port Enabled.
Slave Address
0 to 255
This parameter defines the Slave Node Address for the internal database. All
requests received by the port with this address are processed by the module.
Verify that each device has a unique address on a network. Valid range for this
parameter is 0 to 255.
Baud Rate
300 to 115200
This parameter specifies the baud rate to be used on the port. Valid values are
300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600, and 115200.

ProSoft Technology, Inc.
October 27, 2008
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Parity
None, Odd, Even
Parity is a simple error checking algorithm used in serial communication. This
parameter specifies the type of parity checking to use.
All devices communicating through this port must use the same parity setting.
Data Bits
7 or 8
This parameter sets the number of data bits for each word used by the protocol.
All devices communicating through this port must use the same number of data
bits.
Stop Bits
1 or 2
Stop bits signal the end of a character in the data stream. For most applications,
use one stop bit. For slower devices that require more time to resynchronize, use
two stop bits.
All devices communicating through this port must use the same number of stop
bits.
RTS On
0 to 65535 milliseconds
This parameter sets the number of milliseconds to delay after RTS is asserted
before the data will be transmitted.
RTS Off
0 to 65535 milliseconds
This parameter sets the number of milliseconds to delay after the last byte of
data is sent before the RTS modem signal will be set low.
Minimum Response Delay
0 to 65535
This parameter sets the number of milliseconds to wait to respond to a request
on the port. This is required for slow reacting devices.
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Use CTS Line
Yes or No
This parameter specifies if the CTS modem control line is to be used. If the
parameter is set to No, the CTS line will not be monitored. If the parameter is set
to Yes, the CTS line will be monitored and must be high before the module will
send data. Normally, this parameter is required when half-duplex modems are
used for communication (2-wire).

2.4

Download the Project to the Module
In order for the module to use the settings you configured, you must download
(copy) the updated Project file from your PC to the module.
To Download the Project File
1
2

3

In the tree view in ProSoft Configuration Builder, click once to select the
MVI46-N2 module.
Open the Project menu, and then choose Module / Download. The program
will scan your PC for a valid com port (this may take a few seconds). When
PCB has found a valid com port, the following dialog box will open.

Choose the com port to use from the dropdown list, and then click the
Download button.
The module will perform a platform check to read and load its new settings.
When the platform check is complete, the status bar in ProSoft Configuration
Builder will be updated with the message "Module Running".

ProSoft Technology, Inc.
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Ladder Logic
Ladder logic is required for application of the MVI46-N2 module. Tasks that must
be handled by the ladder logic are module data transfer, special block handling
and status data receipt. Additionally, a power-up handler may be needed to
handle the initialization of the module's data and to clear any processor fault
conditions.
The sample ladder logic, on the ProSoft Solutions CD-ROM, is extensively
commented, to provide information on the purpose and function of each rung. For
most applications, the sample ladder will work without modification.

ProSoft Technology, Inc.
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Diagnostics and Troubleshooting
In This Chapter


Reading Status Data from the Module .................................................. 31



LED Status Indicators............................................................................ 40

The module provides information on diagnostics and troubleshooting in the
following forms:




4.1

Status data values are transferred from the module to the processor.
Data contained in the module can be viewed through the
Configuration/Debug port attached to a terminal emulator.
LED status indicators on the front of the module provide information on the
module's status.

Reading Status Data from the Module
The MVI46-N2 module returns a 30-word Status Data Block that may be used to
determine the module's operating status. This data is located in the module's
database in registers 6000 through 6029.
This data is transferred to the SLC processor every 100 blocks.
The Configuration/Debug port provides the following functionality:






Full view of the module's configuration data
View of the module's status data
Complete display of the module's internal database (registers 0 to 10000)
Version Information
Control over the module (warm boot, cold boot, transfer configuration)

4.1.1 Required Hardware
You can connect directly from your computer's serial port to the serial port on the
module to view configuration information, perform maintenance, and send
(upload) or receive (download) configuration files.
ProSoft Technology recommends the following minimum hardware to connect
your computer to the module:






80486 based processor (Pentium preferred)
1 megabyte of memory
At least one UART hardware-based serial communications port available.
USB-based virtual UART systems (USB to serial port adapters) often do not
function reliably, especially during binary file transfers, such as when
uploading/downloading configuration files or module firmware upgrades.
A null modem serial cable.
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4.1.2 The Configuration/Debug Menu
The Configuration and Debug menu for this module is arranged as a tree
structure, with the Main Menu at the top of the tree, and one or more sub-menus
for each menu command. The first menu you see when you connect to the
module is the Main menu.
Because this is a text-based menu system, you enter commands by typing the
command letter from your computer keyboard in the diagnostic window in
ProSoft Configuration Builder (PCB). The module does not respond to mouse
movements or clicks. The command executes as soon as you press the
command letter — you do not need to press [Enter]. When you type a command
letter, a new screen will be displayed in your terminal application.
Using the Diagnostic Window in ProSoft Configuration Builder
To connect to the module's Configuration/Debug serial port:
1

Start PCB program with the application file to be tested. Right click over the
module icon.

2

On the shortcut menu, choose Diagnostics.
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This action opens the Diagnostics dialog box. Press "?" to display the Main
Menu.

Important: The illustrations of configuration/debug menus in this section are intended as a general
guide, and may not exactly match the configuration/debug menus in your own module.
If there is no response from the module, follow these steps:
1
2

Verify that the null modem cable is connected properly between your
computer's serial port and the module. A regular serial cable will not work.
On computers with more than one serial port, verify that your communication
program is connected to the same port that is connected to the module.

If you are still not able to establish a connection, contact ProSoft Technology for
assistance.
Navigation
All of the sub-menus for this module contain commands to redisplay the menu or
return to the previous menu. You can always return from a sub-menu to the next
higher menu by pressing [M] on your keyboard.
The organization of the menu structure is represented in simplified form in the
following illustration:

ProSoft Technology, Inc.
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The remainder of this section shows you the menus available for this module,
and briefly discusses the commands available to you.
Keystrokes
The keyboard commands on these menus are almost always non-case sensitive.
You can enter most commands in lower case or capital letters.
The menus use a few special characters ([?], [-], [+], [@]) that must be entered
exactly as shown. Some of these characters will require you to use the [Shift],
[Ctrl] or [Alt] keys to enter them correctly. For example, on US English
keyboards, enter the [?] command as [Shift][/].
Also, take care to distinguish capital letter [I] from lower case letter [l] (L) and
number [1]; likewise for capital letter [O] and number [0]. Although these
characters look nearly the same on the screen, they perform different actions on
the module.

4.1.3 Main menu
When you first connect to the module from your computer, your terminal screen
will be blank. To activate the main menu, press the [?] key on your computer's
keyboard. If the module is connected properly, the following menu will appear on
your terminal screen:

Caution: Some of the commands available to you from this menu are designed for advanced
debugging and system testing only, and can cause the module to stop communicating with the
processor or with other devices, resulting in potential data loss or other failures. Only use these
commands if you are specifically directed to do so by ProSoft Technology Technical Support staff.
Some of these command keys are not listed on the menu, but are active nevertheless. Please be
careful when pressing keys so that you do not accidentally execute an unwanted command.
Viewing Version Information
Press [V] to view Version information for the module.
Use this command to view the current version of the software for the module, as
well as other important values. You may be asked to provide this information
when calling for technical support on the product.
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Values at the bottom of the display are important in determining module
operation. The Program Scan Counter value is incremented each time a
module's program cycle is complete.
Tip: Repeat this command at one-second intervals to determine the frequency of program
execution.
Opening the Database Menu
Press [D] to open the Database View menu. Use this menu command to view the
current contents of the module's database.
Resetting diagnostic data
Press [C] to reset the status counters for the client and servers in the module.
Opening the Backplane Menu
Press [B] from the Main Menu to view the Backplane Data Exchange List. Use
this command to display the configuration and statistics of the backplane data
transfer operations.
Tip: Repeat this command at one-second intervals to determine the number of blocks transferred
each second.
Opening the Protocol_Serial_N2 Menu
Press [0] or [1] from the Main Menu to open the Protocol_Serial_N2 menu for N2
Ports 1 and 2.
Use this command to view communication status and statistics for the selected
port. This information can be useful for trouble-shooting communication
problems.
Sending the Configuration File
Press [S] to upload (send) an updated configuration file to the module. For more
information on receiving and sending configuration files, please see Uploading
and Downloading the Configuration File.
Receiving the Configuration File
Press [R] to download (receive) the current configuration file from the module.
For more information on receiving and sending configuration files, please see
Uploading and Downloading the Configuration File.
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Warm Booting the Module
Caution: Some of the commands available to you from this menu are designed for advanced
debugging and system testing only, and can cause the module to stop communicating with the
processor or with other devices, resulting in potential data loss or other failures. Only use these
commands if you are specifically directed to do so by ProSoft Technology Technical Support staff.
Some of these command keys are not listed on the menu, but are active nevertheless. Please be
careful when pressing keys so that you do not accidentally execute an unwanted command.
Press [W] from the Main Menu to warm boot (restart) the module. This command
will cause the program to exit and reload, refreshing configuration parameters
that must be set on program initialization. Only use this command if you must
force the module to re-boot.
Exiting the Program
Caution: Some of the commands available to you from this menu are designed for advanced
debugging and system testing only, and can cause the module to stop communicating with the
processor or with other devices, resulting in potential data loss or other failures. Only use these
commands if you are specifically directed to do so by ProSoft Technology Technical Support staff.
Some of these command keys are not listed on the menu, but are active nevertheless. Please be
careful when pressing keys so that you do not accidentally execute an unwanted command.
Press [Esc] to restart the module and force all drivers to be loaded. The module
will use the configuration stored in the module's Flash ROM to configure the
module.
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4.1.4 Database View Menu
Press [D] from the Main Menu to open the Database View menu. Use this menu
command to view the current contents of the module's database. Press [?] to
view a list of commands available on this menu.

Viewing Register Pages
To view sets of register pages, use the keys described below:
Command

Description

[0]

Display registers 0 to 99

[1]

Display registers 1000 to 1099

[2]

Display registers 2000 to 2099

And so on. The total number of register pages available to view depends on your
module's configuration.
Displaying the Current Page of Registers Again

This screen displays the current page of 100 registers in the database.
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Moving Back Through 5 Pages of Registers
Press [-] from the Database View menu to skip back to the previous 500
registers of data.
Viewing the Previous 100 Registers of Data
Press [P] from the Database View menu to display the previous 100 registers of
data.
Skipping 500 Registers of Data
Hold down [Shift] and press [=] to skip forward to the next 500 registers of data.
Viewing the Next 100 Registers of Data
Press [N] from the Database View menu to select and display the next 100
registers of data.
Viewing Data in Decimal Format
Press [D] to display the data on the current page in decimal format.
Viewing Data in Hexadecimal Format
Press [H] to display the data on the current page in hexadecimal format.
Viewing Data in Floating Point Format
Press [F] from the Database View menu. Use this command to display the data
on the current page in floating point format. The program assumes that the
values are aligned on even register boundaries. If floating-point values are not
aligned as such, they are not displayed properly.
Viewing Data in ASCII (Text) Format
Press [A] to display the data on the current page in ASCII format. This is useful
for regions of the database that contain ASCII data.
Returning to the Main Menu
Press [M] to return to the Main Menu.
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4.1.5 Protocol Serial N2 Menu
Press [0] or [1] to view protocol serial information for ports 1 and 2, respectively.
Use this command to view a variety of error and status screens for the port.
Press [?] to view a list of commands available on this menu.

Redisplaying the Menu
Press [?] to display the current menu. Use this command when you are looking
at a screen of data, and want to view the menu choices available to you.
Viewing Version Information
Press [V] to view Version information for the module.
Use this command to view the current version of the software for the module, as
well as other important values. You may be asked to provide this information
when calling for technical support on the product.
Values at the bottom of the display are important in determining module
operation. The Program Scan Counter value is incremented each time a
module's program cycle is complete.
Tip: Repeat this command at one-second intervals to determine the frequency of program
execution.
Returning to the Main Menu
Press [M] to return to the Main Menu.
Viewing Configuration Information
Press [C] to view configuration information for the selected port, protocol, driver
or device.
Opening the Command List Menu
Press [L] to open the Command List menu. Use this command to view the
configured command list for the module.
ProSoft Technology, Inc.
October 27, 2008
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Opening the Serial Port Menu
Press [S] to open the Serial Port menu. Use this command to view and change
additional serial port driver settings.
Viewing Error and Status Data
Press [E] to display the error/status data for the module.

4.2

LED Status Indicators
The LEDs indicate the module's operating status as follows:
ProSoft
Module

Color

Status

Indication

CFG

Green

On

Data is being transferred between the module and a remote
terminal using the Configuration/Debug port.

Off

No data is being transferred on the Configuration/Debug
port.

P1

Green

On

Data being transferred between master and port 1.

Off

No data

P2

Green

On

Data being transferred between master and port 2.

Off

No data

On

The MVI46-N2 is working normally.

Off

The MVI46-N2 module program has recognized a
communication error.

On

The LED is on when the module is performing a write
operation on the backplane.

Off

The LED is off when the module is performing a read
operation on the backplane. Under normal operation, the
LED should blink rapidly on and off.

Off

The card is not receiving any power and is not securely
plugged into the rack.

Green

The module is operating normally.

Red

The program has detected an error or is being configured. If
the LED remains red for over 10 seconds, the program has
probably halted. Remove the card from the rack and re-insert
the card to restart the module's program.

Off

The battery voltage is OK and functioning.

On

The battery voltage is low or battery is not present. Allow
battery to charge by keeping module plugged into rack for 24
hours. If BAT LED still does not go off, contact ProSoft
Technology, as this is not a user serviceable item.

APPStatus

BP ACT

OK

Amber

Amber

Red/
Green

BAT

Red

If the APP, BP ACT and OK LEDs blink at a rate of every one-second, this
indicates a serious problem with the module. Call ProSoft Technology support to
arrange for repairs.
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4.2.1 Clearing a Fault Condition
Typically, if the OK LED on the front of the module turns red for more than ten
seconds, a hardware problem has been detected in the module, or the program
has exited.
To clear the condition, follow these steps:
1
2
3
4
5
6

Turn off power to the rack
Remove the card from the rack
Verify that all jumpers are set correctly
If the module requires a Compact Flash card, verify that the card is installed
correctly
Re-insert the card in the rack and turn the power back on
Verify the configuration data being transferred to the module from the SLC
processor.

If the module's OK LED does not turn green, verify that the module is inserted
completely into the rack. If this does not cure the problem, contact ProSoft
Technology Support.

4.2.2 Troubleshooting
Use the following troubleshooting steps if you encounter problems when the
module is powered up. If these steps do not resolve your problem, please contact
ProSoft Technology Technical Support.
Processor Errors
Problem Description

Steps to take

Processor Fault

Verify that the module is plugged into the slot that has been configured
for the module.
Verify that the slot in the rack configuration has been set up correctly in
the ladder logic.

Processor I/O LED
flashes

This indicates a problem with backplane communications. Verify that all
modules in the rack are configured in the ladder logic.

Module Errors
Problem Description

Steps to take

BP ACT LED remains
off or blinks slowly

This indicates that backplane transfer operations are failing. Connect to
the module's Configuration/Debug port to check this.
To establish backplane communications, verify the following items:

OK LED remains red

ProSoft Technology, Inc.
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The processor is in Run mode.



The backplane driver is loaded in the module.



The module is configured for read and write block data transfer.



The ladder logic handles all read and write block situations.



The module is configured in the processor.

The program has halted or a critical error has occurred. Connect to the
Configuration/Debug port to see if the module is running. If the program
has halted, turn off power to the rack, remove the card from the rack and
re-insert the card in the rack, and then restore power to the rack.
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Product Specifications
The Johnson Controls N2 Communication Module allows Rockwell Automation
SLC I/O compatible processors to interface easily with Johnson Controls N2
master devices.
The inRAx N2 module acts as an input/output module between the Johnson
Controls Metasys network and the SLC backplane. The module is capable of
receiving commands from a master device. The data transfer from the SLC
processor is asynchronous from the actions on the Johnson Controls Metasys
network. An internal database in the module exchanges data between the
processor and the Johnson Controls Metasys Master (NCM, N-30, NAE, NIE).
The inRAx N2 module acts as an input/output module between the Johnson
Controls Metasys network and the SLC backplane. The module is capable of
receiving commands from a master device. The data transfer from the SLC
processor is asynchronous from the actions on the Johnson Controls Metasys
network. An internal database in the module exchanges data between the
processor and the Johnson Controls Metasys Master (NCM, N-30, NAE, NIE).

5.1.1 General Specifications





Single Slot - 1746 backplane compatible (Local or extended I/O rack only.
Remote rack not supported)
The module is recognized as an Input/Output module and has access to
processor memory for data transfer between processor and module using
M0/M1 files
Ladder Logic is used for data transfer between module and processor.
Sample ladder file included
Configuration data obtained from configuration text file downloaded to
module. Sample configuration file included

ProSoft Technology, Inc.
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5.1.2 Hardware Specifications
Specification

Description

Backplane Current Load

800 ma @ 5V (from backplane)

Operating Temperature

0 to 60°C (32 to 140°F)

Storage Temperature

-40 to 85°C (-40 to 185°F)

Shock

30g operational, 50g non-operational

Relative Humidity

5% to 95% (non-condensing)

Vibration

5 g from 10150 Hz

Processor

Compatible with Rockwell Automation SLC 5/02 M0/M1
capable processors or newer

LED indicators

Module status, Backplane transfer status, Application status,
Serial activity and error LED status

Debug/Configuration port (CFG)
CFG Port (CFG)

RJ45 (DB-9M with supplied cable)
RS-232 only

Configuration Connector

RJ45 RS-232 Connector (RJ45 to DB-9 cable shipped with
unit)

Application Ports
Application Serial port (PRT1,
PRT2) (Serial Modules)

Two RJ45 RS-232/422/485 Application ports

5.1.3 Functional Specifications
Some of the general specifications include:






Support for the storage and transfer of internal database registers to/from the
SLC processor's controller tags
Two ports to emulate a Johnson Controls N2 slave
Supports the following N2 objects:
o Binary Input: Up to 960 points
o Analog Input: Up to 300 points
o Binary Output: Up to 960 points
o Analog Output: Up to 300 points
Supported Commands/Sub-commands
o 0/4: Poll Message No Acknowledge
o 0/5: Poll Message with Acknowledge
o 0/9: Status Update
o 1/1: Read Analog Input Attributes
o 1/2: Read Binary Input Attributes
o 1/3: Read Analog Output Attributes
o 1/4: Read Binary Output Attributes
o 2/1: Write Analog Input Attributes
o 2/2: Write Binary Input Attributes
o 2/3: Write Analog Output Attributes
o 2/4: Write Binary Output Attributes
o 7/2/3: Override Analog Output
o 7/2/4: Override Binary Output
o F: Identify Device Type
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The following commands are recognized, and acknowledged, but are not
communicated in any way to the PLC/SLC, and do not return any data:
o 0/0: Time Update
o 0/8: Warm Start
o All other commands return a Bad Command Error Code



Configurable through the configuration file for the following:
o Slave Address (assignable individually for Port 1 and 2)
o Analog Input Object Count
o Binary Input Object Count
o Analog Output Object Count
o Binary Output Object Count



Warning and Alarming functions performed on Analog Input and Binary Input
data types
Change of State Response buffering
Communication status error codes and statistics returned per port




Memory mapping is pre-assigned to optimize data access and to ease
implementation
A port configured as a Johnson Controls N2 slave permits a remote master to
interact with data contained in the module. This data is derived from the SLC
processor.

5.2

Functional Overview
This section provides an overview of how the MVI46-N2 module transfers data
using the N2 protocol. You should understand the important concepts in this
chapter before you begin installing and configuring the module.

5.2.1 General Concepts
The following discussion explains several concepts that are important for
understanding the operation of the MVI46-N2 module.
Module Power Up
On power up the module begins performing the following logical functions:
1

Initialize hardware components:
a
b
c

2
3

Initialize SLC backplane driver.
Test and clear all RAM.
Initialize the serial communication ports.

Initialize module register space.
Enable slave driver on selected ports.

After the module is configured, the module begins receiving and transmitting
messages with Johnson Controls N2 devices on the network.

ProSoft Technology, Inc.
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Main Logic Loop
Upon completing the power up configuration process, the module enters an
infinite loop that performs the functions shown in the following diagram.

Backplane Data Transfer
The MVI46-N2 module communicates directly over the SLC backplane. All data
for the module is contained in the module's M1 file. Data is moved between the
module and the SLC processor across the backplane using the module's M-files.
The SLC scan rate and the communication load on the module determine the
update frequency of the M-files. The COP instruction can be used to move data
between user data files and the module's M1 file.

Page 46 of 68

ProSoft Technology, Inc.
October 27, 2008

Reference

MVI46-N2 ♦ SLC Platform
Johnson Controls N2 Communication Module

The following illustration shows the data transfer method used to move data
between the SLC processor, the MVI46-N2 module and the N2 network.

All data transferred between the module and the processor over the backplane is
through the M0 and M1 files. Ladder logic must be written in the SLC processor
to interface the M-file data with data defined in the user-defined data files in the
SLC. All data used by the module is stored in its internal database.
User data contained in this database is continuously read from the M1 file.
Block identification codes define specific functions to the module. The module
uses the following block numbers:
Block Range

Descriptions

9001

Write Binary Object

9002

Write Analog Output

9998

Warm-boot control block.

9999

Cold-boot control block.

Each block has a defined structure depending on the data content and the
function of the data transfer.
Normal Data Transfer
This version of the module provides for direct access to the data in the module.
All data related to the module is stored in the module's M1 file. To write data to
the module, use the COP instruction to copy data from a user file to the module's
M1 file.
ProSoft Technology, Inc.
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Command Control Blocks
Command control blocks are special blocks used to control the module or
request special data from the module. The current version of the software
supports four command control blocks: Binary Output Write, Analog Output
Write, Warm Boot and Cold Boot.
Warm Boot
This block is sent from the SLC processor to the module when the module is
required to perform a warm-boot (software reset) operation. The structure of the
control block is shown below:
M1 Offset
6800

Description
9998

Length
1

Cold Boot
This block is sent from the SLC processor to the module when the module is
required to perform the cold boot (hardware reset) operation. This block is sent to
the module when a hardware problem is detected by the ladder logic that
requires a hardware reset. The structure of the control block is shown below:
M1 Offset
6800

Description
9999

Length
1

Pass-Through Control Blocks
The module will pass blocks with identification codes of 9001 and 9002 to the
processor for each received function 7/2/4, and 7/2/3 command respectively. The
structure of the pass-through control blocks are shown in the following tables:
Block 9001
M0 Offset
0
1
2
3

Description
0
9001
Binary Point Offset
Binary Value

Length
1
1
1
1

Description
0
9002
Analog Point Offset
Analog Value

Length
1
1
1
2

Block 9002
M0 Offset
0
1
2
3

The ladder logic should copy the received data and control the processor as
expected by the master device. The processor must respond to the pass-through
control block with the following format:
M0 Offset
0

Description
0

Length
1

This informs the module that the command has been processed and can be
cleared from the pass-through queue.
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5.2.2 Data Flow Between the MVI46-N2 Module and the SLC
Processor
The following section describes the flow of data between the two pieces of
hardware (SLC processor and MVI46-N2 module). Each port on the module is
configured to emulate a Johnson Controls N2 slave device. The operation of
each port is dependent on this configuration.
Slave Driver
The Slave Driver Mode allows the MVI46-N2 module to respond to data read and
write commands issued by a master on the Johnson Controls N2 network. The
following flowchart describes the flow of data into and out of the module. The
Module Setup section provides a list of the parameters that must be defined for a
slave port.
All write requests will be passed directly to the processor. The following
illustration shows the data flow for a slave port.

5.3

Cable Connections
The application ports on the MVI46-N2 module support RS-232, RS-422, and
RS-485 interfaces. Please inspect the module to ensure that the jumpers are set
correctly to correspond with the type of interface you are using.
Note: When using RS-232 with radio modem applications, some radios or modems require
hardware handshaking (control and monitoring of modem signal lines). Enable this in the
configuration of the module by setting the UseCTS parameter to 1.
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5.3.1 RS-232 Configuration/Debug Port
This port is physically an RJ45 connection. An RJ45 to DB-9 adapter cable is
included with the module. This port permits a PC based terminal emulation
program to view configuration and status data in the module and to control the
module. The cable for communications on this port is shown in the following
diagram:

Disabling the RSLinx Driver for the Com Port on the PC
The communication port driver in RSLinx can occasionally prevent other
applications from using the PC's COM port. If you are not able to connect to the
module's configuration/debug port using ProSoft Configuration Builder (PCB),
HyperTerminal or another terminal emulator, follow these steps to disable the
RSLinx Driver.
1
2

Open RSLinx and go to Communications>RSWho
Make sure that you are not actively browsing using the driver that you wish to
stop. The following shows an actively browsed network:
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Notice how the DF1 driver is opened, and the driver is looking for a processor
on node 1. If the network is being browsed, then you will not be able to stop
this driver. To stop the driver your RSWho screen should look like this:

Branches are displayed or hidden by clicking on the

4

or the

icons.

When you have verified that the driver is not being browsed, go to
Communications>Configure Drivers
You may see something like this:

If you see the status as running, you will not be able to use this com port for
anything other than communication to the processor. To stop the driver press
the "Stop" on the side of the window:

5

After you have stopped the driver you will see the following:
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Upon seeing this, you may now use that com port to connect to the debug
port of the module.

Note: You may need to shut down and restart your PC before it will allow you to stop the driver
(usually only on Windows NT machines). If you have followed all of the above steps, and it will not
stop the driver, then make sure you do not have RSLogix open. If RSLogix is not open, and you
still cannot stop the driver, then reboot your PC.

5.3.2 RS-232
When the RS-232 interface is selected, the use of hardware handshaking
(control and monitoring of modem signal lines) is user definable. If no hardware
handshaking will be used, the cable to connect to the port is as shown below:

RS-232: Modem Connection
This type of connection is required between the module and a modem or other
communication device.

The "Use CTS Line" parameter for the port configuration should be set to 'Y' for
most modem applications.
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RS-232: Null Modem Connection (Hardware Handshaking)
This type of connection is used when the device connected to the module
requires hardware handshaking (control and monitoring of modem signal lines).

RS-232: Null Modem Connection (No Hardware Handshaking)
This type of connection can be used to connect the module to a computer or field
device communication port.

Note: If the port is configured with the "Use CTS Line" set to 'Y', then a jumper is required between
the RTS and the CTS line on the module connection.
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5.3.3 RS-422

5.3.4 RS-485
The RS-485 interface requires a single two or three wire cable. The Common
connection is optional and dependent on the RS-485 network. The cable required
for this interface is shown below:

Note: Terminating resistors are generally not required on the RS-485 network, unless you are
experiencing communication problems that can be attributed to signal echoes or reflections. In this
case, install a 120 ohm terminating resistor on the RS-485 line.
RS-485 and RS-422 Tip
If communication in the RS-422/RS-485 mode does not work at first, despite all
attempts, try switching termination polarities. Some manufacturers interpret +/and A/B polarities differently.
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5.3.5 DB9 to RJ45 Adaptor (Cable 14)

5.4

MVI46-N2 Status Data Area
This section contains a listing of the data contained in the MVI46-N2 status data
object.
M1 Offset

Content

Description

6000

Program cycle counter

This value is incremented each time a
complete program cycle occurs in the
module.

6001 -6004

Product Name

6005 - 6006

Product Code as ASCII string

This register contains the product code of
"N2"

6007 - 6008

Revision level as ASCII string

This register contains the product version for
the current software.

6009 - 6010

Operating system level as ASCII
string

This register contains the month and year
values for the program operating system.

6011 - 6012

Run number as ASCII string

This register contains the run number value
for the current software.

6013

Number of requests - Port 1

Contains the number of port messages sent
out of the port.

6014

Number of responses - Port 1

Contains the total number of messages
received on the port.

6015

Number of errors sent - Port 1

Contains the total number of message errors
sent out of the port.

6016

Number of errors received - Port 1

Contains the total number of message errors
received on the port.
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M1 Offset

Content

Description

6017

Number of requests - Port 2

Contains the total number of messages sent
out the port.

6018

Number of responses - Port 2

Contains the total number of messages
received on the port.

6019

Number of errors sent - Port 2

Contains the total number of message errors
sent out the port.

6020

Number of errors received - Port 2

Contains the total number of message errors
received on the port.

6021

Backplane Transfer Writes

Contains the total number of write blocks
transferred from the processor to the module.

6022

Backplane Transfer Reads

Contains the total number of read blocks
transferred from the module to the processor.

6023

Backplane Transfer Errors

Contains the total number of block errors
recognized by the module.

6024

Current Error - Port 1

For a slave port, this field contains the value
of the current error code returned. For a
master port, this field contains the index of
the currently executing command.

6025

Last Error - Port 1

For a slave port, this field contains the value
of the last error code returned. For a master
port, this field contains the index of the
command with the error.

6026

Current Error - Port 2

For a slave port, this field contains the value
of the current error code returned. For a
master port, this field contains the index of
the current executing command.

6027

Last Error - Port 2

For a slave port, this field contains the value
of the last error code returned. For a master
port, this field contains the index of the
command with an error.

A data file should be allocated in the ladder logic to hold this block of data. The
size of the block of data is 35 words.

5.5

N2 Data Object
Network
Point
Type

Network
Point
Address

Unit

Description

Notes

AI

1

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file, for example
Analog Input Object Count: 16

AI

…

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Analog Input Object Count: 16

AI

300

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Analog Input Object Count: 16
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Network
Point
Type

Network
Point
Address

Unit

Description

Notes

BI

1

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Binary Input Object Count: 16

BI

...

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Binary Input Object Count: 16

BI

960

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Binary Input Object Count: 16

AO

1

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Analog Output Object Count: 16

AO

...

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Analog Output Object Count: 16

AO

256

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Analog Output Object Count: 16

BO

1

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. That is, Binary
Output Object Count: 16

BO

...

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Analog Output Object Count: 16

BO

960

User Defined in
Ladder Program

User Defined in
Ladder Program

Actual number of points
supported is defined in
configuration file. for example
Analog Output Object Count: 16

ADF points are not supported. A write to an ADF point will return A. A read from
an ADF point will return a status of unreliable and data of zero.
ADI points are not supported. A write to an ADI point will return A. A read from an
ADI point will return a status of unreliable and data of zero.
BD points are not supported. A write to an BD point will return A. A read from an
BD point will return a status of unreliable and data of zero.
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ProSoft Technology, Inc. (ProSoft) is committed to providing the most efficient
and effective support possible. Before calling, please gather the following
information to assist in expediting this process:
1
2
3

Product Version Number
System architecture
Network details

If the issue is hardware related, we will also need information regarding:
1

Module configuration and contents of file
o Module Operation
o Configuration/Debug status information
o LED patterns

2

Information about the processor and user data files as viewed through and
LED patterns on the processor.
Details about the serial devices interfaced, if any.

3

6.1

How to Contact Us: Technical Support
Internet

Web Site: http://www.prosoft-technology.com/support
(http://www.prosoft-technology.com/support)
E-mail address: support@prosoft-technology.com
(mailto:support@prosoft-technology.com)

Asia Pacific
+603.7724.2080, support.asia@prosoft-technology.com
(mailto:support.asia@prosoft-technology.com)
Languages spoken include: Chinese, English
Europe (location in Toulouse, France)
+33 (0) 5.34.36.87.20, support.EMEA@prosoft-technology.com
(mailto:support.emea@prosoft-technology.com)
Languages spoken include: French, English
ProSoft Technology, Inc.
October 27, 2008

Page 59 of 68

MVI46-N2 ♦ SLC Platform
Johnson Controls N2 Communication Module

Support, Service & Warranty

North America/Latin America (excluding Brasil) (location in California)
+1.661.716.5100, support@prosoft-technology.com (mailto:support@prosofttechnology.com)
Languages spoken include: English, Spanish
For technical support calls within the United States, an after-hours answering
system allows pager access to one of our qualified technical and/or application
support engineers at any time to answer your questions.
Brasil (location in Sao Paulo)
+55-11-5084-5178 , eduardo@prosoft-technology.com (mailto:eduardo@prosofttechnology.com)
Languages spoken include: Portuguese, English

6.2

Return Material Authorization (RMA) Policies and Conditions
The following RMA Policies and Conditions (collectively, "RMA Policies") apply to
any returned Product. These RMA Policies are subject to change by ProSoft
without notice. For warranty information, see "Limited Warranty". In the event of
any inconsistency between the RMA Policies and the Warranty, the Warranty
shall govern.

6.2.1 All Product Returns:
a) In order to return a Product for repair, exchange or otherwise, the
Customer must obtain a Returned Material Authorization (RMA) number
from ProSoft and comply with ProSoft shipping instructions.
b) In the event that the Customer experiences a problem with the Product for
any reason, Customer should contact ProSoft Technical Support at one of
the telephone numbers listed above (page 59). A Technical Support
Engineer will request that you perform several tests in an attempt to
isolate the problem. If after completing these tests, the Product is found to
be the source of the problem, we will issue an RMA.
c) All returned Products must be shipped freight prepaid, in the original
shipping container or equivalent, to the location specified by ProSoft, and
be accompanied by proof of purchase and receipt date. The RMA number
is to be prominently marked on the outside of the shipping box. Customer
agrees to insure the Product or assume the risk of loss or damage in
transit. Products shipped to ProSoft using a shipment method other than
that specified by ProSoft or shipped without an RMA number will be
returned to the Customer, freight collect. Contact ProSoft Technical
Support for further information.
d) A 10% restocking fee applies to all warranty credit returns whereby a
Customer has an application change, ordered too many, does not need,
etc.
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6.2.2 Procedures for Return of Units Under Warranty:
A Technical Support Engineer must approve the return of Product under
ProSoft's Warranty:
a) A replacement module will be shipped and invoiced. A purchase order will
be required.
b) Credit for a product under warranty will be issued upon receipt of
authorized product by ProSoft at designated location referenced on the
Return Material Authorization.

6.2.3 Procedures for Return of Units Out of Warranty:
a) Customer sends unit in for evaluation
b) If no defect is found, Customer will be charged the equivalent of $100
USD, plus freight charges, duties and taxes as applicable. A new
purchase order will be required.
c) If unit is repaired, charge to Customer will be 30% of current list price
(USD) plus freight charges, duties and taxes as applicable. A new
purchase order will be required or authorization to use the purchase order
submitted for evaluation fee.
The following is a list of non-repairable units:
o 3150 - All
o 3750
o 3600 - All
o 3700
o 3170 - All
o 3250
o 1560 - Can be repaired, only if defect is the power supply
o 1550 - Can be repaired, only if defect is the power supply
o 3350
o 3300
o 1500 - All

6.2.4 Purchasing Warranty Extension:
a) ProSoft's standard warranty period is three (3) years from the date of
shipment as detailed in "Limited Warranty (page 62)". The Warranty
Period may be extended at the time of equipment purchase for an
additional charge, as follows:
•
•
•

Additional 1 year = 10% of list price
Additional 2 years = 20% of list price
Additional 3 years = 30% of list price
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LIMITED WARRANTY
This Limited Warranty ("Warranty") governs all sales of hardware, software and
other products (collectively, "Product") manufactured and/or offered for sale by
ProSoft, and all related services provided by ProSoft, including maintenance,
repair, warranty exchange, and service programs (collectively, "Services"). By
purchasing or using the Product or Services, the individual or entity purchasing or
using the Product or Services ("Customer") agrees to all of the terms and
provisions (collectively, the "Terms") of this Limited Warranty. All sales of
software or other intellectual property are, in addition, subject to any license
agreement accompanying such software or other intellectual property.

6.3.1 What Is Covered By This Warranty
a) Warranty On New Products: ProSoft warrants, to the original purchaser,
that the Product that is the subject of the sale will (1) conform to and
perform in accordance with published specifications prepared, approved
and issued by ProSoft, and (2) will be free from defects in material or
workmanship; provided these warranties only cover Product that is sold as
new. This Warranty expires three years from the date of shipment (the
"Warranty Period"). If the Customer discovers within the Warranty Period
a failure of the Product to conform to specifications, or a defect in material
or workmanship of the Product, the Customer must promptly notify
ProSoft by fax, email or telephone. In no event may that notification be
received by ProSoft later than 39 months. Within a reasonable time after
notification, ProSoft will correct any failure of the Product to conform to
specifications or any defect in material or workmanship of the Product,
with either new or used replacement parts. Such repair, including both
parts and labor, will be performed at ProSoft's expense. All warranty
service will be performed at service centers designated by ProSoft.
b) Warranty On Services: Materials and labor performed by ProSoft to repair
a verified malfunction or defect are warranteed in the terms specified
above for new Product, provided said warranty will be for the period
remaining on the original new equipment warranty or, if the original
warranty is no longer in effect, for a period of 90 days from the date of
repair.

6.3.2 What Is Not Covered By This Warranty
a) ProSoft makes no representation or warranty, expressed or implied, that
the operation of software purchased from ProSoft will be uninterrupted or
error free or that the functions contained in the software will meet or
satisfy the purchaser's intended use or requirements; the Customer
assumes complete responsibility for decisions made or actions taken
based on information obtained using ProSoft software.
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b) This Warranty does not cover the failure of the Product to perform
specified functions, or any other non-conformance, defects, losses or
damages caused by or attributable to any of the following: (i) shipping; (ii)
improper installation or other failure of Customer to adhere to ProSoft's
specifications or instructions; (iii) unauthorized repair or maintenance; (iv)
attachments, equipment, options, parts, software, or user-created
programming (including, but not limited to, programs developed with any
IEC 61131-3, "C" or any variant of "C" programming languages) not
furnished by ProSoft; (v) use of the Product for purposes other than those
for which it was designed; (vi) any other abuse, misapplication, neglect or
misuse by the Customer; (vii) accident, improper testing or causes
external to the Product such as, but not limited to, exposure to extremes
of temperature or humidity, power failure or power surges; or (viii)
disasters such as fire, flood, earthquake, wind and lightning.
c) The information in this Agreement is subject to change without notice.
ProSoft shall not be liable for technical or editorial errors or omissions
made herein; nor for incidental or consequential damages resulting from
the furnishing, performance or use of this material. The user guide
included with your original product purchase from ProSoft contains
information protected by copyright. No part of the guide may be duplicated
or reproduced in any form without prior written consent from ProSoft.

6.3.3 Disclaimer Regarding High Risk Activities
Product manufactured or supplied by ProSoft is not fault tolerant and is not
designed, manufactured or intended for use in hazardous environments requiring
fail-safe performance including and without limitation: the operation of nuclear
facilities, aircraft navigation of communication systems, air traffic control, direct
life support machines or weapons systems in which the failure of the product
could lead directly or indirectly to death, personal injury or severe physical or
environmental damage (collectively, "high risk activities"). ProSoft specifically
disclaims any express or implied warranty of fitness for high risk activities.

6.3.4 Intellectual Property Indemnity
Buyer shall indemnify and hold harmless ProSoft and its employees from and
against all liabilities, losses, claims, costs and expenses (including attorney's
fees and expenses) related to any claim, investigation, litigation or proceeding
(whether or not ProSoft is a party) which arises or is alleged to arise from Buyer's
acts or omissions under these Terms or in any way with respect to the Products.
Without limiting the foregoing, Buyer (at its own expense) shall indemnify and
hold harmless ProSoft and defend or settle any action brought against such
Companies to the extent based on a claim that any Product made to Buyer
specifications infringed intellectual property rights of another party. ProSoft
makes no warranty that the product is or will be delivered free of any person's
claiming of patent, trademark, or similar infringement. The Buyer assumes all
risks (including the risk of suit) that the product or any use of the product will
infringe existing or subsequently issued patents, trademarks, or copyrights.
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a) Any documentation included with Product purchased from ProSoft is
protected by copyright and may not be duplicated or reproduced in any
form without prior written consent from ProSoft.
b) ProSoft's technical specifications and documentation that are included
with the Product are subject to editing and modification without notice.
c) Transfer of title shall not operate to convey to Customer any right to make,
or have made, any Product supplied by ProSoft.
d) Customer is granted no right or license to use any software or other
intellectual property in any manner or for any purpose not expressly
permitted by any license agreement accompanying such software or other
intellectual property.
e) Customer agrees that it shall not, and shall not authorize others to, copy
software provided by ProSoft (except as expressly permitted in any
license agreement accompanying such software); transfer software to a
third party separately from the Product; modify, alter, translate, decode,
decompile, disassemble, reverse-engineer or otherwise attempt to derive
the source code of the software or create derivative works based on the
software; export the software or underlying technology in contravention of
applicable US and international export laws and regulations; or use the
software other than as authorized in connection with use of Product.
f) Additional Restrictions Relating To Software And Other Intellectual
Property
In addition to compliance with the Terms of this Warranty, Customers
purchasing software or other intellectual property shall comply with any
license agreement accompanying such software or other intellectual
property. Failure to do so may void this Warranty with respect to such
software and/or other intellectual property.

6.3.5 Disclaimer of all Other Warranties
The Warranty set forth in What Is Covered By This Warranty (page 62) are in lieu
of all other warranties, express or implied, including but not limited to the implied
warranties of merchantability and fitness for a particular purpose.

6.3.6 Limitation of Remedies **
In no event will ProSoft or its Dealer be liable for any special, incidental or
consequential damages based on breach of warranty, breach of contract,
negligence, strict tort or any other legal theory. Damages that ProSoft or its
Dealer will not be responsible for included, but are not limited to: Loss of profits;
loss of savings or revenue; loss of use of the product or any associated
equipment; loss of data; cost of capital; cost of any substitute equipment,
facilities, or services; downtime; the claims of third parties including, customers of
the Purchaser; and, injury to property.
** Some areas do not allow time limitations on an implied warranty, or allow the exclusion or
limitation of incidental or consequential damages. In such areas, the above limitations may not
apply. This Warranty gives you specific legal rights, and you may also have other rights which vary
from place to place.
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6.3.7 Time Limit for Bringing Suit
Any action for breach of warranty must be commenced within 39 months
following shipment of the Product.

6.3.8 No Other Warranties
Unless modified in writing and signed by both parties, this Warranty is
understood to be the complete and exclusive agreement between the parties,
suspending all oral or written prior agreements and all other communications
between the parties relating to the subject matter of this Warranty, including
statements made by salesperson. No employee of ProSoft or any other party is
authorized to make any warranty in addition to those made in this Warranty. The
Customer is warned, therefore, to check this Warranty carefully to see that it
correctly reflects those terms that are important to the Customer.

6.3.9 Allocation of Risks
This Warranty allocates the risk of product failure between ProSoft and the
Customer. This allocation is recognized by both parties and is reflected in the
price of the goods. The Customer acknowledges that it has read this Warranty,
understands it, and is bound by its Terms.

6.3.10 Controlling Law and Severability
This Warranty shall be governed by and construed in accordance with the laws of
the United States and the domestic laws of the State of California, without
reference to its conflicts of law provisions. If for any reason a court of competent
jurisdiction finds any provisions of this Warranty, or a portion thereof, to be
unenforceable, that provision shall be enforced to the maximum extent
permissible and the remainder of this Warranty shall remain in full force and
effect. Any cause of action with respect to the Product or Services must be
instituted in a court of competent jurisdiction in the State of California.
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